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Flat Plate Boundary Layer

Chapter 2 Flat Plate Boundary Laver

Objectives

e Creating the SOLIDWORKS part needed for the Flow Simulation

e Setting up Flow Simulation projects for internal flow

e Setting up a two-dimensional flow condition

e Initializing the mesh

e Selecting boundary conditions

e Inserting global goals, point goals and equation goals for the calculations
e Running the calculations

e Using Cut Plots to visualize the resulting flow field

e Use of XY Plots for velocity profiles, boundary layer thickness, displacement thickness,
momentum thickness and friction coefficients

e Use of Excel templates for XY Plots

e Comparison of Flow Simulation results with theories and empirical data

e Cloning of the project

Problem Description

In this chapter, we will use SOLIDWORKS Flow Simulation to study the two-dimensional
laminar and turbulent flow on a flat plate and compare with the theoretical Blasius boundary layer
solution and empirical results. The inlet velocity for the 1 m long plate is 5 m/s and we will be
using air as the fluid for laminar calculations and water to get a higher Reynolds number for
turbulent boundary layer calculations. We will determine the velocity profiles and plot the
profiles using the well-known boundary layer similarity coordinate. The variation of boundary-
layer thickness, displacement thickness, momentum thickness and the local friction coefficient
will also be determined. We will start by creating the part needed for this simulation; see figure
2.0.

Inlet section _ _
/ Lines for velocity profiles

Outlet section

Ideal walls
Real wall

Figure 2.0 SOLIDWORKS model for flat plate boundary layer study
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Flat Plate Boundary Layer

Creating the SOLIDWORKS Part

1.

Start by creating a new part in SOLIDWORKS: select File>>New and click on the OK button in
the New SOLIDWORKS Document window. Click on Front Plane in the FeatureManager
design tree and select Front from the View Orientation drop down menu in the graphics
window.

Q| ERI& S >
¥

Q}j ﬁ' Partl (Default<<Default>_Display
History
Sensors ﬁjv@v@ﬁvgv
r Annotations W @ w

G—
2=g Material <not specified=

b=d =
[j_-] Top Plane @ @ @ @

[1] Right Plane
L, origin Front (Ctrl+1)
Figure 2.1a) Selection of front plane Figure 2.1b) Selection of front view

Click on the Sketch tab and select Corner Rectangle.

? — B .
DS SOLIDWORKS File Edit Vie

Sketch Smart
Dimension D | =Y - @ N -'f;h
r\. %

Figure 2.2 Selecting a sketch tool

Make sure that you have MMGS (millimeter, gram, second) chosen as your unit system. You can
check this by selecting Tools>>Options from the SOLIDWORKS menu and selecting the
Document Properties tab followed by clicking on Units. Check the circle for MMGS and click
on the OK button to close the window. Click to the left and below the origin in the graphics
window and drag the rectangle to the right and upward. Fill in the parameters for the rectangle:
1000 mm wide and 100 mm high; see Figure 2.3b). Close the Rectangle dialog box by clicking on

W

. Right click in the graphics window and select Zoom/Pan/Rotate>>ﬁ Zoom to Fit.
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Parameters ~
o -100.00 :
., 0.00 :
o -100.00 :
°, 100.00 :
° 1000.00 :
°, 100.00 :
° 1000.00 :
s 0.00 :

Figure 2.3a) Parameter settings for the rectangle

| Zoom/Pan/Rotate » |||ﬁ Zoom to Fit

Figure 2.3b) Zooming in the graphics window

4. Repeat steps 2 and 3 but create a larger rectangle outside of the first rectangle. Dimensions are
shown in figure 2.4.

Parameters S
o -120.00 :
= -20.00 :
o -120.00 :
o, 120.00 :
o hozo.00 m
o 120.00 :
. 1020.00 :
" -20.00 :

Figure 2.4 Dimensions of second larger rectangle
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5. Select Features tab and Extruded Boss/Base. Check the box for [¥| Direction 2 and click

OK to exit the Boss-Extrude Property Manager.

7 F .
DS SOLIDWORKS | File Edit

ﬁ @ @ Swept Boss/Base

Extruded | Revolved
Boss/Base | Boss/Base

Extruded Boss/Base

Extrudes a sketch or selected sketch
contours in one or two directions to
create a solid feature.

Figure 2.5a) Selection of extrusion feature

? F .
JpS SOLIDWORKS |  File Edt

Feature-s| Sketch | E'.raluate| DimXper

(<]

¢ BB ¢ S

@] Boss-Extrude @

A

Figure 2.5b) Closing the property manager

6. Select Front from the View Orientation drop down menu in the graphics window. Click on
Front Plane in the FeatureManager design tree. Click on the Sketch tab and select the Line
sketch tool.

? e £
J 25 SOLIDWORKS |  File Edit

c ¢ [e-wv-
Sketch amart
Dimension Line (L)

= = Sketches a line.

Figure 2.6 Selection of the line sketch tool
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7. Draw a vertical line in the Y-direction in the front plane starting at the lower inner surface of the
sketch. Set the Parameters and Additional Parameters to the values shown in figure 2.7. Close

the Line Properties dialog and the Inert Line dialog.
Parameters ta
& 2000 i
i
A - o
|1 90.00 <
Additional Parameters -~
7 200.00 -
x -
/ 0.00 -
¥ -
e 200,00 i
x -
/ 20.00 -
¥ -
AXx 000 =
AY 2000 =

Figure 2.7 Parameters for vertical line

8. Repeat steps 6 and 7 three more times and add three more vertical lines to the sketch: the second
line at X = 400 mm with a length of 40 mm, the third line at X = 600 mm with a length of 60 mm
and the fourth line at X = 800 mm with a length of 80 mm. These lines will be used to plot the
boundary layer velocity profiles at different streamwise positions along the flat plate. Close the

Line Properties dialog L4 and the Insert Line dialog. Save the SOLIDWORKS part with the

following name: Flat Plate Boundary Layer Study 2017. Rename the newly created sketch in

the FeatureManager design tree; see figure 2.8. You will need to left click twice to rename the
sketch.

Flat Plate Boundary Layer Study 2017
History

Sensors

Annotations

Material <not specified>
Front Plane

Top Plane

Right Plane

Origin

Boss-EBxtrudel
(-1x=0204,0608m

Figure 2.8 Renaming the sketch for boundary layer velocity profiles
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9. Click on the Rebuild symbol e in the SOLIDWORKS menu. Repeat step 6 and draw a
horizontal line in the X-direction starting at the origin of the lower inner surface of the sketch. Set
the Parameters and Additional Parameters to the values shown in figure 2.9 and close the Line
Properties dialog and the Insert Line dialog. Rename the sketch in the FeatureManager design
tree and call it x =0 — 0.9 m. Click on the Rebuild symbol.

Parameters Lo

g\ 900.00 %
|l“ 0.00°

| 3

1

Additional Parameters L

A 0.00
A 0.00

A 900.00
A 0.00

1F 4
o |

4F 4P

[*:]
& |
=
[~]
=1
1F

»

Figure 2.9 Sketching a line in the X-direction

10. Next, we will create a split line. Repeat step 6 once again but this time select the Top Plane and
draw a line in the Z-direction through the origin of the lower inner surface of the sketch. It will
help to zoom in and rotate the view to complete this step. Set the Parameters and Additional
Parameters to the values shown in figure 2.10 and close the dialog. Click on the Rebuild
symbol.

Parameters

& 2000 -
[N 0000

¥

i1 »

Additional Parameters

0.00

4k 4 p

-10.00

0.00

1k 4P

10.00

NN

»

0.00

1

»

AY 20.00

Figure 2.10 Drawing a line in the Z-direction
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11. Rename the new sketch in the FeatureManager design tree and call it Split Line. Select
Insert>>Curve>>Split Line... from the SOLIDWORKS menu. Select Projection under Type
to Split. Select Split Line for Sketch to Project under Selections. For Faces to Split, select the

W

. You have

surface where you have drawn your split line; see figure 2.11b). Close the dialog
now finished the part for the flat plate boundary layer. Select File>>Save from the
SOLIDWORKS menu.

Insert | Tools ‘Window Help » D '@'

Boss/Base L

Cut 3 .
Features 3 .
Pattern/Mirror 4

Fastening Feature »

FeatureWorks 4

Surface 3

Face 4

| Curve 4 ” @ Split Line...

Figure 2.11a) Creating a split line

Features | Sketch | Evaluate | DimXpert | SOLIDWORKS Add-Ins LPELU@B-T-v

it Plate Boundary Layer Study 2017 ...

%|||E‘$‘e‘ i Histary

@ Split Line @ ] Sensars

[ Annotations

v X E
B Material <not specified:
Selections # || Front Plane
C I Split Line Top Plane
— Right Plane
Ea Face<l> b Crigin
]Boss—Extrudel

| (3%=0.2,040608m
Li-ix=0-09m
I split Linel

[ single direction
[[] rReverse direction

Figure 2.11b) Selection of surface for the split line

Chapter 2 -7 -



Flat Plate Boundary Layer

Setting Up the Flow Simulation Project

12. If Flow Simulation is not available in the menu, you have to add it from SOLIDWORKS menu:
Tools>>Add Ins... and check the corresponding SOLIDWORKS Flow Simulation 2017 box
under SOLIDWORKS Add-Ins and click OK to close the Add-Ins window. Select Tools>>Flow
Simulation>>Project>>Wizard to create a new Flow Simulation project. Enter Project name:
“Flat Plate Boundary Layer Study.” Click on the Next > button. Select the default SI (m-kg-s)
unit system and click on the Next> button once again.

Tools | Window Help | - H-&- vm 8 {0} = Flat Plate Bo... (2

SOLIDWORKS Applications » '\@ Rib Wrap -ﬂ U
Xpress Products * | B praft O Intersect Referer'!ce Curves

Flow Simulation 3 Project Y Mew..

ANSY517.1 * % Wizard...
Tneart I |

Figure 2.12a) Starting a new Flow Simulation project

,
wews-pomeens

Froject

Praject name: Flat Plate Boundary Lager Study

Comments:

Figure 2.12b) Creating a name for the project

13. Use the default Internal Analysis type and click on the Next> button once again.

- _
Analysis type Consider closed cavities
@ Intemal Exclude cavities without flaw conditions
(7)) External [ ] Exclude internal space
Physical Features | Value
Heat conduction in solids
Radiation
Time-dependent
Gravity
Rotation

Figure 2.13 Excluding cavities without flow conditions
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14. Select Air from the Gases and add it as Project Fluid. Select Laminar Only from the Flow
Type drop down menu. Click on the Next > button. Use the default Wall Conditions and click
on the Next > button. Insert 5 m/s for Velocity in X direction as Initial Conditions and click on
the Finish button. You will get a fluid volume recognition failure message. Answer Yes to this
question and create a lid on each side of the model. Answer Yes to the questions when you create
the lids.

, ‘

Fluids | Path | = ew,.. ®
; Pre-Defined
Pre-Defined
Pre-Defined
Pre-Defined
i Carbon dioxide Pre-Defined
“ew Chlorine Pre-Defined
Ethane Pre-Defined
Pre-Defined
Pre-Defined
: Pre-Defined h Add
| Project Fluids | Defautt Fiuid | R
Air ( Gases )
Flow Characteristic Value -
Flow type Laminar Only E
High Mach number flow
Humidity - )

Figure 2.14 Selection of fluid for the project and flow type

15. Select Tools>>Flow Simulation>>Computational Domain.... Click on the 2D simulation
W

button under Type and select XY plane. Close the Computational Domain dialog

Tools|Window Help f‘ O & -5- vmj.

SOLIDWORKS Applications 3 @ Rib Wrap
Xpress Products 4 Re

| Flow Simulation » Project
ANSY517.1 3 _—
m Asset Publisher.. @ General Settings...
B, Defeature... Units...
{E'EE Export To AEC... |@ Computational Dornain...

Figure 2.15a) Modifying the computational domain

@ Computational Domain @
v X
Type s

3D simulation
@ 2D simulation

@ XY plane

Figure 2.15b) Selecting 2D simulation in the XY plane
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16. Sclect Tools>>Flow Simulation>>Global Mesh.... Select Manual under Type. Change Nx to
300 and Ny to 200. Click on the OK button (green check mark) to exit the Initial Mesh window.

Tools | Window Help A ‘ B - @ - ﬁ - % - vE

SOLIDWORKS Applications L4 @] Rib @ Wri
Xpress Products 4 g

Flow Simulation 4 Project
ANSYS17.1 ¢ Insert
ﬁ Asset Publisher... @ General Settings
§ Defeature... Units...
‘:E'Eg Export To AEC... @ Computational [
T e M Global Mesh...

Figure 2.16a) Modifying the initial mesh

3 Global Mesh Settings @
v X
Type [~

Automatic
Manual

Basic Mesh ~
Nx 300 :
Ny 200 S

Figure 2.16b) Changing the number of cells in two directions

Selecting Boundary Conditions

17. Select the < Flow Simulation analysis tree tab, open the Input Data folder by clicking on
the plus sign next to it and right click on Boundary Conditions. Select Insert Boundary
Condition.... Select Wireframe as the Display Style. Right click in the graphics window and
select Zoom/Pan/Rotate>>Zoom to Fit. Once again, right click in the graphics window and
select Zoom/Pan/Rotate>>Rotate View. Click and drag the mouse so that the inner surface of
the left boundary is visible. Right click again and unselect Zoom/Pan/Rotate>>Rotate View.
Right click on the left inflow boundary surface and select Select Other. Select the Face
corresponding to the inflow boundary. Select Inlet Velocity in the Type portion of the Boundary
Condition window and set the velocity to 5 m/s in the Flow Parameters window. Click OK to

exit the window. Right click in the graphics window and select ﬂ Zoom to Area and select an
area around the left boundary.
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@ Flat Plate Boundary Layer Study
Eﬁ Input Data

------- @ Computational Domain

e @ Fluid Subdomains

" @-B8 Results (Not loaded)

Figure 2.17a) Inserting boundary condition

Zoom/Pan/Rotate

k

P [fas

}fbx Face Coordinate Spstem
z

Reference axis:

Type

ElS]]

Inlet Mass Flow
Inlet Volume Flow
Inlet Velocity

Inlet Mach Mumber
Cutlet Mass Flow
Outlet Volume Flow
Qutlet Velocity

Flow Parameters

[651 (4= L4

¥V Hmis

Fully developed flow

v 0K
¥ Cancel

Figure 2.17¢c) Velocity boundary condition on the inflow
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Figure 2.17b) Modifying the view




18.

Flat Plate Boundary Layer
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Figure 2.17d) Inlet velocity boundary condition indicated by arrows
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Red arrows pointing in the flow direction appear indicating the inlet velocity boundary condition;
see figure 2.17d). Right click in the graphics window and select Zoom to Fit. Right click again in

73l
the graphics window and select == Rotate View once again to rotate the part so that the inner

right surface is visible in the graphics window. Right click and click on ﬁSelect. Right click

on Ei] Boundary Conditions in the Flow Simulation analysis tree and select Insert
Boundary Condition.... Right click on the outflow boundary surface and select Select Other.
Select the Face corresponding to the outflow boundary. Click on the Pressure Openings button
in the Type portion of the Boundary Condition window and select Static Pressure. Click OK to
exit the window. If you zoom in on the outlet boundary you will see blue arrows indicating the
static pressure boundary condition; see figure 2.18b).

v G Fiat Plate Boundary Layer .

S/ EBlo[S[a]

Ff Boundary Condition @ -
v X
Selection ~

,}fvx Face Coordinate System
=

Reference axis: E

Type A [ |101325 Pa
(& [ |

Environment Pressure =
Static Pressure i

Total Pressure

Figure 2.18a) Selection of static pressure as boundary condition at the outlet of the flow region
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Figure 2.18b) Outlet static pressure boundary condition

19. Enter the following boundary conditions: Ideal Wall for the lower and upper walls at the inflow
region; see figures 2.19. These will be adiabatic and frictionless walls.

{;»x Global Coordinate Systemn

Reference axis: @
Type o

[+ ][]

‘ Real Wall ‘

Figure 2.19 Ideal wall boundary condition for two wall sections
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20. The last boundary condition will be in the form of a Real Wall. We will study the development
of the boundary layer on this wall.

Figure 2.20 Real wall boundary condition for the flat plate

Inserting Global Goals

21. Right click on Goals in the Flow Simulation analysis tree and select Insert Global Goals....
Select Friction Force (X) as a global goal. Exit the Global Goals window. Right click on Goals

X
in the Flow Simulation analysis tree and select Insert Point Goals.... Click on the Iil Point
Coordinates button. Enter 0.2 m for X coordinate and 0.02 m for Y coordinate and click on the

Add Point button \i‘ Add three more points with the coordinates shown in figure 2.21¢e). Check
the Value box for Velocity (X). Exit the Point Goals window. Rename the goals as shown in
figure 2.21f). Right click on Goals in the Flow Simulation analysis tree and select Insert
Equation Goal.... Click on PG Velocity (X) at x = 0.2 m goal in the Flow Simulation analysis
tree, multiply by 0.2 (for x = 0.2 m) and divide by /.5/6E-5 (kinematic viscosity of air at room
temperature [ v = 1.516E-5 m?/s] to get an expression for the Reynolds number in the Equation
Goal window; see figure 2.21g). Select Dimensionless LMA from the dimensionality drop down
menu. Exit the Equation Goal window. Rename the equation goal to Reynolds number at x =
0.2 m. Insert three more equation goals corresponding to the Reynolds numbers at the three other
x locations. For a definition of the Reynolds number, see page 2-21.
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¥ Global Goals @
v X

Parameters A
Parameter Mir A M BL Us =«
Density (Fluid] v
Mass (Fluid)

Mass Flow Rate =
Velocity
Velocity [¥]
Velacity (1)
Velocity (Z)

Mach Mumber

Heat Flux

Wall Temperature =
Heat Transfer Rats

£5: Flat Plate Boundary Layer Study

i Total Enthalpy Ra
EI@ Input Data

IFEEENEEEEEREEEEEEEEEEE

@ C tati D . Mormal Force
i Ulfﬂpu atona . omain Mormal Force (¥
o gy Fluid Subdomains Normal Farce (1)
|_:_|Eﬁ Boundary Conditions Normal Force ()
-] Inlet Velocity 1 Force |
------ Eﬁ Static Pressure 1 Force [¥)
L Ideal Wall 1 Farce [¥)
e 'Eﬁ Real Wall 1 Faorce [Z)
...... P Goal Friction Force
o F Mesl Insert Global Goals... Friction Force [¥]
Figure 2.21a) Inserting global goals Figure 2.21b) Selection of friction force
%, Point Goals
L
Points
— X
] .
Insert Global Geals...
P Insert Point Goals... 'ﬁj |
Figure 2.21c) Inserting point goals Figure 2.21d) Selecting point coordinates
Add point
xvz ¥ [m] ¥ [m] 7 [m
0.2 0.02 0
0.4 0.02 0
0.6 0.02 0
0.5 0.02 0

Figure 2.21¢) Coordinates for point goals
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E‘F Goals
P-‘ GG Friction Force (¥) 1
.# PG Velocity (X) atx=02m

F- PG Velocity () at x = 0.4 m B v | Equation Goal 1 Dimersinless L
F. PG Velocity (X) atx=06m || Fupression
F. PG Velocity () atx=08 m |{PG Velocity (X) at x =0.2 m}*0.2/1.516E-5

Figure 2.21f) Renaming the point goals  Figure 2.21g) Entering an equation goal

Running the Calculations

22. Select Tools>>Flow Simulation>>Solve>>Run from the SOLIDWORKS menu to start the

calculations. Click on the Run button in the Run window. Click on the goals e button in the
Solver window to see the List of Goals.

Tools | Window Help ‘ O--EB-5- v ;] {3} - Flat Plate Bo..

C?

SOLIDWORKS Applications k @ Rib Wrap 'ﬁ] U @
Kpress Products k Reference Curves

Flow Simulation 3 Project 2

AMSY51T7.1 3

Insert r

Aszszet Publisher...

Q
B

General Settings...
Defeature... Units...

Export To AEC... Computational Domain...

Global Mesh...
Select

- . Component Control...
Magnified Selection

& = 8O

. Calculation Control Options...
Box Selection

Lasso Selection | Sohve k| [ Run.

Figure 2.22a) Starting calculations

! |
S 0 W

Startup
Fiun
[V] Mesh [] Take previous results
] schve
@ Mew calculation
Continue calculation

Figure 2.22b) Run window
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r
=
=5 Solver:

Flat Plate Boundary Layer Study [Default] (Flat Plate Boundary Layer Study 2017.5LDPRT)

File Calculation View Inset Window Help

i u > O |EOFE e 2
=
o Info Log
Pararneter Value Event Iteration Time
Status Solver is finished. Mesh generation started 0 10:33:43
Total cells 60,000 Mesh generation normally finished 0 10:33:46
Fluid cells 60,000 Preparing data for calculation 0 10:33:48
Fluid cells contacting solids 996 Calculation started 0 10:33:50,
Iterations 120 Calculation has converged since the following criteria are satisfied: 119 10:36:13
Last iteration finished 10:36:13 Goals are converged 119
CPU time per last iteration 00:00:02 Calculation finished 120 10:36:14
Travels 1.53262
Iterations per1 travel FE
Cpu time 0:2:25
Calculation time left 0:0:0

E List of Goals

Reynolds number atx= 0.2 m 66876.6
Reynolds number atx = 0.4 m 134436
Reynolds number atx = 0.6 m 202458

Name Current Value Progress Criterion Averaged Value
GG Friction Force (X) 1 0.00014714 N 6.57397e-005  0.000147478 N
PG Velocity (X) atx =02 m 5.06925 m/s 0.00203833 n  5.06925 m/s

PG Velocity (X) atx =04 m 5.09511 my's 0.00281197 n 5.09511 m/s
PG Velocity (X) atx = 0.6 m 511543 m/s 0.00339618 n 511534 m/s

PG Velocity (X) atx =08 m 513259 m/s 0.00379582 n 513184 m/s

26,8909 66B76.6
741946 134436
134413 202454

{Reynolds number atx= 0.8 m 270849

200.307 270809

Figure 2.22c) Solver window

Using Cut Plots to Visualize the Flow Field

23.

Open the Results folder, right click on R Cut Plots in the < Flow Simulation analysis tree

under Results and select Insert.... Select the Front Plane from the % FeatureManager
design tree. Slide the Number of Levels slide bar to 255. Select Pressure from the Parameter
drop down menu. Click OK to exit the Cut Plot window. Figure 2.23a) shows the high pressure
region close to the leading edge of the flat plate. Rename the cut plot to Pressure. You can get
more lighting on the cut plot by selecting Tools>>Flow
Simulation>>Results>>Display>>Lighting from the SOLIDWORKS menu. Right click on the
Pressure Cut Plot in the Flow Simulation analysis tree and select Hide.

Repeat this step but instead choose Velocity (X) from the Parameter drop down menu. Rename
the second cut plot to Velocity (X). Figures 2.23b) and 2.23c) show the velocity boundary layer
close to the wall.
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101326.26
10132617
F 1032608
10132599
101325.90
10132581
B 10122572
T 10132563
T 10132554
o+ 101325.45
101325.35
10132526
10132517
101325.08
10132499

Pressure [Fa]

Figure 2.23a) Pressure distribution along the flat plate.
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Figure 2.23b) X — Component of Velocity distribution on the flat plate.

Figure 2.23c) Close up view of the velocity boundary layer.

Using XY Plots with Templates

24, Place the file “graph 2.24¢).xIsm” on the desktop. This file and the other exercise files are

available for download at the SDC Publications website. Click on the % FeatureManager

design tree. Click on the sketch x = 0.2, 0.4, 0.6, 0.8 m. Click on the < Flow Simulation
analysis tree tab. Right click XY Plot and select Insert.... Check the Velocity (X) box. Open the
Resolution portion of the XY Plot window and slide the Geometry Resolution as far as it goes
to the right. Click on the Evenly Distribute Qutput Points button and increase the number of
points to 500. Open the Options portion and check the Display boundary layer box. Select the
“Excel Workbook (*.xlIsx)” from the drop down menu. Click Export to Excel to create the XY
Plot window. An Excel file will open with a graph of the velocity in the boundary layer at
different streamwise positions.
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Double click on the graph 2.24c¢) file to open the file. Click on Enable Content if you get a
Security Warning that Macros have been disabled. If Developer is not available in the menu of
the Excel file, you will need to do the following: Select File>>Options from the menu and click
on the Customize Ribbon on the left-hand side. Check the Developer box on the right-hand side
under Main Tabs. Clock OK to exit the Excel Options window.

Click on the Developer tab in the Excel menu for the graph 2.24c¢) file and select Visual Basic
on the left-hand side to open the editor. Click on the plus sign next to VBAProject (XY Plot
1.xIsx) and click on the plus sign next to Microsoft Excel Objects. Right click on Sheet2 (Plot
Data) and select View Object.

Select Modulel in the Modules folder under VBAProject (graph 2.24c¢).xlsm). Select
Run>>Run Macro from the menu of the MVB for Applications window. Click on the Run
button in the Macros window. Figure 2.24c¢) will become available in Excel showing the
streamwise velocity component u (m/s) versus wall normal coordinate y (m). Close the XY Plot
window and the graph 2.24¢) window in Excel. Exit the XY Plot window in SOLIDWORKS
Flow Simulation and rename the inserted xy-plot in the Flow Simulation analysis tree to
Laminar Velocity Boundary Layer.

Parameters -~
EAII -
[Cpensity (Fluid)
G [B[B[S[@]&] |Dre
DTemperature
? DTemperature [Fluid)
% ﬂ Flat Plate Boundary Layer Study 2017 DVEIGCU .
~—
2 History [Clvelocity 1)
Sensors [Clvelocity @)
—— . DMach Mumber
k Annotatmns Flvelocity RRF
e o - i

v [@] Solid Bodies(3) C

[ More Parameters... ]

EE Material <not specified=
[ﬂ Front Plane Resolution -
[ﬂ Top Plane WAl B

o
Right Plane o
I[:E]. Origin ~

* @ Boss-Extrudel Options ~
|E (-)x=0204 06 08m UseCADgeometr}r
E (-)x=0-09m [¥]Interpolate
F @ Split Linel [¥] Display boundary layer
LID1 Merge connected lines
LID2 ’Eltcel Workbook [*.xlsy) v]
Figure 2.24a) Sketch for the XY Plot Figure 2.24b) Settings for the XY Plot
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6
5 44—+t 1 1
4 e
T e S o o e e e e e x=0.2m
******* x=0.4m
****** x=0.6m
""""""""""""" x=0.8m

0 0.002 0.004 0.006 0.008 0.01
y(m)

Figure 2.24c) Boundary layer velocity profiles on a flat plate at different streamwise positions

Comparison of Flow Simulation Results with Theory and Empirical Data

25. We now want to compare this velocity profile with the theoretical Blasius velocity profile for
laminar flow on a flat plate. First, we have to normalize the steamwise Velocity (X) component
with the free stream velocity. Secondly, we have to transform the wall normal coordinate into the
similarity coordinate for comparison with the Blasius profile. The similarity coordinate is
described by

n= y\/% (2.1)

where y (m) is the wall normal coordinate, U (m/s) is the free stream velocity, x (m) is the
distance from the leading edge and v (m?/s) is the kinematic viscosity of the fluid.

26. Place the file “graph 2.25a)” on the desktop. Repeat step 24 to plot Figure 2.25a). Rename the
xy-plot to Comparison with Blasius Profile.
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We see in figure 2.25a) that all profiles at different streamwise positions collapse on the same
Blasius curve when we use the boundary layer similarity coordinate.

1
0.8
e o 2 s x=0.2m
u/U 8/ N T T R N N N B N x=0.4m
0.4 ; 44 T e x=0.6m
/j """"""""""""" x=0.8m
0.2 / ——— Theory
/
0 7
0 1 2 4 5 6

Figure 2.25a) Velocity profiles in comparison with the theoretical Blasius profile (full line)

The Reynolds number for the flow on a flat plate is defined as
Re, = — (2.2)

The boundary layer thickness & is defined as the distance from the wall to the location where the
velocity in the boundary layer has reached 99% of the free stream value. The theoretical
expression for the thickness of the laminar boundary layer is given by

4.91x
é = Tres (2.3)
, and the thickness of the turbulent boundary layer
0.16
§= lei (2.4)

From the data of figure 2.24¢) we can see that the thickness of the laminar boundary layer is close
to 3.80 mm at Re,, = 66,877 corresponding to x = 0.2 m. The free stream velocity at x = 0.2 m is
U= 5.069 m/s, see figure 2.22¢) for list of goals in solver window, and 99% of this value is Us =
5.018 m/s. The boundary layer thickness § = 3.80 mm from Flow Simulation was found by
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finding the y position corresponding to the Ug velocity. This value for § at x = 0.2 m and
corresponding values further downstream at different x locations are available in the Plot Data for
Figure 2.25a). The different values of the boundary layer thickness can be compared with values
obtained using equation (2.3). In table 2.1 are comparisons shown between boundary layer
thickness from Flow Simulation and theory corresponding to the four different Reynolds numbers
shown in figure 2.24c). The Reynolds number varies between Re, = 66,877 at x = 0.2 m and

Re, =270,849 at x = 0.8 m.

x (m) | & (mm) § (mm) | Percent (%) Us U m? Re,
Simulation | Theory | Difference (m/s) | (m/s) v (T)

0.2 3.83 3.80 0.9 5.019 5.069 | 0.00001516 | 66,877

0.4 5.33 5.36 0.6 5.044 5.095 | 0.00001516 | 134,436

0.6 6.46 6.55 1.3 5.064 5.115 | 0.00001516 | 202,458

0.8 7.42 7.55 1.7 5.081 5.133 | 0.00001516 | 270,849

Table 2.1 Comparison between Flow Simulation and theory for laminar boundary layer thickness

27. Place the file “graph 2.25b)” on the desktop. Repeat step 24 to plot Figure 2.25b). Rename the
xy-plot to Boundary Layer Thickness.

0.1
10(L00
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100(LOOO

—————————— Flow Simulation

5/ x
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0.01
Re x

Figure 2.25b) Comparison between Flow Simulation and theory on boundary layer thickness
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28. We now want to study how the local friction coefficient varies along the plate. It is defined as the
local wall shear stress divided by the dynamic pressure:

Tw
Crn = e (2.12)

The theoretical local friction coefficient for laminar flow is given by

Crx = 0224 Re, < 5-10° (2.13)
and for turbulent flow
Crx = % 5-10° < Re, < 107 (2.14)

Place the file “graph 2.26” on the desktop. Repeat step 24 but this time choose the sketch x =0 —
0.9 m, uncheck the box for Velocity (X) and check the box for Shear Stress. Use the file “graph
2.26” to create Figure 2.26. Rename the xy-plot to Local Friction Coefficient. Figure 2.26
shows the local friction coefficient versus the Reynolds number compared with theoretical values
for laminar boundary layer flow.

0.1
1(LO 1000 10(|)OO 100000 100(L000
Cf,x 0.01 : Flow Simulation
—— Theory
0.001
Re

X

Figure 2.26 Local friction coefficient as a function of the Reynolds number
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The average friction coefficient over the whole plate Cr is not a function of the surface roughness
for the laminar boundary layer but a function of the Reynolds number based on the length of the
plate Re;; see figure E3 in Exercise 8 at the end of this chapter. This friction coefficient can be
determined in Flow Simulation by using the final value of the global goal, the X-component of
the Shear Force Fy, see figure 2.22¢), and dividing it by the dynamic pressure times the area 4 in
the X-Z plane of the computational domain related to the flat plate.

Fp 0.0001475N
pUZA  3:1.204kg/m3-52m?/s?-1m-0.004m

Cr = =0.00245 (2.15)

UL 5m/s-1m
Rep=—=—7""—7+
v 1.516:1075m2/s

=3.3-10° (2.16)

The average friction coefficient from Flow Simulation can be compared with the theoretical value
for laminar boundary layers

Cr = 222 = 0.002312 Re, <5105 2.17)

Rep,

This is a difference of 6 %. For turbulent boundary layers the corresponding expression is

_0.0315

= 5-10° < Re;, < 107 (2.18)
L

If the boundary layer is laminar on one part of the plate and turbulent on the remaining part, the
average friction coefficient is determined by

6
Cr=2205 1 (0.0315Re.” — 1.328,/Re,,) (2.19)

ReL1/7 ReL

where Re,, is the critical Reynolds number for laminar to turbulent transition.
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Flat Plate Boundary Layer

29. In the next step, we will clone the project. Select Tools>>Flow Simulation>>Project>>Clone
Project.... Enter the Project Name “Flat Plate Boundary Layer Study Using Water.” Select
Create New Configuration and exit the Clone Project window. Next, change the fluid to water
in order to get higher Reynolds numbers. Start by selecting Tools>>Flow Simulation>>General
Settings... from the SOLIDWORKS menu. Click on Fluids in the Navigator portion, select Air
and click on the Remove button. Select Water from the Liquids and Add it as the Project Fluid.
Change the Flow type to Laminar and Turbulent; see figure 2.27d). Click on the OK button to
close the General Setting window.

Tools | Window  Help

A D-m-EB-8-9-

s - @ §83 ~ Flat Plate Bo... | (2) Search

SOLUIDWORKS Applications
Kpress Products
Flow Simulation

AMNSYS171
ﬁ Acset Publisher...

§y Defeature...
T+ Export To AEC...

Select

Gll; Magnified Selection

v Diraft ﬁ;l.-:l Intersect

¢ lf Rib Wrap ° o W

Reference Curves

Instant3D

b Project

Inszert

Q
B’

General Settings...

Units...

Computational Domain...
Global Mesh...

Component Control...

i m B O

Calenlatinn Cantenl Matinnc

Figure 2.27a) Cloning the project

[ Mew..
5 Wizard...

Rebuild
Automatic Rebuild
4 Display All Callouts

Show Basic Mesh

Basic Mesh Color...
Clone Project...

Clone Project @
L A 1
Project Name ~
Flat Plate Boundary Laver Study Using ' ater
Configuration s
||=|a [Create Mew v]
Tools | Window  Help
= Default1)
Kpress Products
2 |Default - Prod
Flow Simulation
ANSYS171
Options Y
D Copy results m‘ Asset Publisher...

Figure 2.27b) Creating a new project
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Flow type Laminar and Turbulent
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Figure 2.27d) Selection of fluid and flow type

Select Tools>>Flow Simulation>>Computational Domain... Set the size of the computational
domain to the values shown in figure 2.28a). Click on the OK button to exit. Select Tools>>Flow
Simulation>>Global Mesh... from the SOLIDWORKS menu, select Manual Type and change
the Number of cells per X: to 400 and the Number of Cells per Y: to 200. Also, click on
Control Planes. Change the Ratio for X to -5 and the Ratio for Y to -100. This is done to
increase the number of cells close to the wall where the velocity gradient is high. Click on the
OK button to exit. Select Tools>>Flow Simulation>>Calculation Control Options... from the
SOLIDWORKS menu. Change the Maximum travels value to 5 by first changing to Manual
from the drop down menu. Travel is a unit characterizing the duration of the calculation. Click on
the OK button to exit.
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Figure 2.28a) Setting the size of the computational domain
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Figure 2.28b) Increasing the number of cells and changing the distribution of cells
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Figure 2.28c) Calculation control options
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,
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Figure 2.28d) Setting maximum travels

Select Tools>>Flow Simulation>>Project>>Show Basic Mesh from the SOLIDWORKS menu.
We can see in figure 2.28f) that the density of the mesh is much higher close to the flat plate at
the bottom wall as compared to the region further away from the wall.

Window Help | O-F-H-5- v d §83 - Flat Plate Bo... | (2) Search ¢

SOLIDWORKS Applications 3 @ Rib Wrap 'ﬂ U
Kpress Products 3 Intersect Refereqce Curves

| Flow Simulation r | Project P Mew..
ANSY5171 3 % Wizard...
Insert r
Asset Publisher... Rebuild
Eﬁ @ General Settings...
) Automatic Rebuild
B Defeature... Units...
Display All Callouts
%&E Export To AEC... @ Computational Domain... al iy
FE inhal Moch | Show Basic Mesh

Figure 2.28¢) Showing the basic mesh

Figure 2.28f) Mesh distribution in the X-Y plane
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31. Right click the Inlet Velocity Boundary Condition in the Flow Simulation analysis tree and
select Edit Definition.... Open the Boundary Layer section and select Laminar Boundary
Layer. Click OK to exit the Boundary Condition window. Right click the Reynolds number at
x = 0.2 m goal and select Edit Definition.... Change the viscosity value in the Expression to
1.004E-6. Click on the OK button to exit. Change the other three equation goals in the same way.
Select Tools>>Flow Simulation>>Solve>>Run to start calculations. Click on the Run button in
the Run window.

Boundary Layer
(™) Turbulent

i@ Laminar

Figure 2.29a) Selecting a laminar boundary layer

Pt ills) | |Heynu:-|u:|s nurber at © = 0.2 m Dimengionless L, ~

Expression
{PG Velocity (X) at x = 0.2 m}*0.2,/1.004E-6

Figure 2.29b) Modifying the equation goals

] 1
Run F . ...
Bun

[V] Mesh [ Take previous results

Fsohe

@ Mew calculation

Continue calculation

Figure 2.29c¢) Creation of mesh and starting a new calculation
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@ Solver: Flat Plate Boundary Layer Study Using Water [Default{1)] (Flat Plate Boundary Layer Study 2017.SI.DPRE _

File Calculation View

Insert Window Help

x w0 [EOE e 2]

| o Info Log
Parameter Value Event Tteration Time
Status Solver is finished. Mesh generation started 0 11:46:36
Total cells 76,200 Mesh generation normally finished 0 11:46:39
Fluid cells 76,200 Preparing data for calculation 0 11:46:40
Fluid cells contacting solids 1,158 Calculation started 0 11:46:42
Iterations 178 Calculation has converged since the following criteria are satisfied: 177 11:53:34
Last iteration finished 11:53:34 Goals are converged 177
CPU time per last iteration 00:00:02 Calculation finished 178 11:53:36
Travels 206551
Iterations per 1 travel a7
Cpu time 0:6:54
Calculation time left 0:0:0

Name Current Value Progress Criterion Averaged Value
GG Friction Force (X) 1 11 M 914 M M

PG Velocity (X) atx=02m 502326 m/s 0.000703429  5.02332 m/s

PG Velocity (X) atx=04 m 503973 m/fs 000112782 n  5.03978 m/s

PG Velocity (X) atx =06 m 5.05469 m/s 0.00126261 n  5.0547 m/s

PG Velocity (X) atx=0.8m 506878 m/s 000154417 n 5.069 m/s
Reynolds numberatx =02 m 1.00065e+006 140125 1.00066e+006
Reynolds number atx =04 m 2.00786e+006 449,329 2.00787e+006
Reynolds number atx = 0.6 m 3.02073e+006 754.546 3.02074e+006
SReynoIds numberatx=08m 403887 e+006 123041 4.03904e+006

Figure 2.29d) Solver window and goals table for calculations of turbulent boundary layer
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32. Place the file “graph 2.30a)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Velocity
Boundary Layer. An Excel file will open with a graph of the streamwise velocity component
versus the wall normal coordinate; see figure 2.30a). We see that the boundary layer thickness is
much higher than the corresponding laminar flow case. This is related to higher Reynolds number
at the same streamwise positions as in the laminar case. The higher Reynolds numbers are due to
the selection of water as the fluid instead of air that has a much higher value of kinematic
viscosity than water.

6
********** x=0.2m
******* x=0.4m
****** x=0.6m
‘e — x=0.8m
0
0 0.002 0.004 0.006 0.008 0.01

y (m)
Figure 2.30a) Flow Simulation comparison between turbulent boundary layers at Re,, = 10° —
4.04-10°

As an example, the turbulent boundary layer thickness from figure 2.30a) is 3.55 mm at x = 0.2 m
which can be compared with a value of 4.44 mm from equation (2.4), see table 2.2.

x (m) § (mm) & (mm) Percent (%) U m? Re,
Simulation | Empirical | Difference (m/s) v (T)
0.2 3.165 445 29 5.023 | 0.000001004 | 1,000,650
0.4 5.59 8.05 31 5.040 | 0.000001004 | 2,007,860
0.6 8.01 11.39 30 5.055 | 0.000001004 | 3,020,730
0.8 10.37 14.57 29 5.069 | 0.000001004 | 4,038,870

Table 2.2 Comparison between Flow Simulation and empirical results for turbulent boundary
layer thickness

Place the file “graph 2.30b)” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Turbulent Boundary
Layer Thickness. An Excel file will open with a graph of the boundary layer thickness versus the
Reynolds number; see figure 2.30b).

Chapter 2 - 31 -



Flat Plate Boundary Layer
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Figure 2.30b) Boundary layer thickness for turbulent boundary layers at Re, = 10 — 4.04 - 10°

33. Place the file “graph 2.31” on the desktop. Repeat step 24 and choose the sketch x = 0.2, 0.4,
0.6, 0.8 m and check the box for Velocity (X). Rename the xy-plot to Comparison with One-
Sixth Power Law. An Excel file will open with Figure 2.31. In figure 2.31 we compare the
results from Flow Simulation with the turbulent profile for »n = 6. The power law turbulent
profiles suggested by Prandtl are given by

U _ Iyi/n
0= @ (2.20)
1 R
0.8
R 1 x=0.2m
u/U ******* x=0.4m
o4 +—1+—1T"7 -1+ x=0.6m
""""""""""""" x=0.8m
n=6
0.2
0
0 0.2 0.4 0.6 0.8 1

y/é

Figure 2.31 The same profiles as in figure 2.30a) compared with one-sixth power law for
turbulent profile.
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34, Place the file “graph 2.32” on the desktop. Repeat step 24 and choose the sketch x =0 — 0.9 m,

X

uncheck the box for Velocity (X) and check the box for Shear Stress. Rename the xy-plot to
Local Friction Coefficient for Laminar and Turbulent Boundary Layer. An Excel file will
open with figure 2.32. Figure 2.32 is showing the Flow Simulation is able to capture the local
friction coefficient in the laminar region in the Reynolds number range 10,000 — 150,000. At Re
= 150,000 there is an abrupt increase in the friction coefficient caused by laminar to turbulent
transition. In the turbulent region the friction coefficient is decreasing again but the local friction
coefficient from Flow Simulation is significantly lower than empirical data.

0.1
1000 10000 100000 100(LOOO 10000000
0.01
ffffffffff Flow Simulation
——— Theory
0.001
0.0001

Re

X

Figure 2.32 A comparison between Flow Simulation (dashed line) and theoretical laminar and
empirical turbulent friction coefficients

The average friction coefficient over the whole plate Cr is a function of the surface roughness for
the turbulent boundary layer and also a function of the Reynolds number based on the length of
the plate Re;; see figure E3 in Exercise 8. This friction coefficient can be determined in Flow
Simulation by using the final value of the global goal, the X-component of the Shear Force Frand
dividing it by the dynamic pressure times the area 4 in the X-Z plane of the computational
domain related to the flat plate; see figure 2.28a) for the size of the computational domain.
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Fg 0.1309N

Cs = =
F 7 1024~ Loogkg/m3-52m?/s2-1m-0.004m
Zp 2

=0.00262 2.21)

UL 5m/s-1m
Re,=—=—7—"—7—
v 1.004-107%m?2 /s

= 4.98-10° (2.22)

The variation and final values of the goal can be found in the solver window during or after
calculation by clicking on the associated flag; see figures 2.33 and 2.29d).

?@, Solver: Flat Plate Boundary Layer Study Using Water [Default(1)] (Flat Plate Boundary Layer Study 2017.5LDPRT)

File Calculation View Inset Window Help

‘= n > O\ |E]OfH)ie | ®

IF —_—

0o | Insert Goals Plot(Ctrl+G) |

Figure 2.33 Obtaining the current value of the global goal
For comparison with Flow Simulation results we use equation (19) with Re_,. = 150,000

00315 1
- ReL1/7 ReL

6
C (0.0315Re,7 — 1.328,/Re,; ) = 0.00341 (2.23)

This is a difference of 23%.
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Exercises

2.1 Change the number of cells per X and Y—see figure 2.16b)—for the laminar boundary layer
and plot graphs of the boundary layer thickness, displacement thickness, momentum
thickness and local friction coefficient versus Reynolds number for different combinations of
cells per X and Y. Compare with theoretical results.
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2.2 Choose one Reynolds number and one value of number of cells per X for the laminar
boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per Y. Compare with theoretical results.

2.3 Choose one Reynolds number and one value of number of cells per Y for the laminar
boundary layer and plot the variation in boundary layer thickness, displacement thickness and
momentum thickness versus number of cells per X. Compare with theoretical results.

2.4 Import the file “Leading Edge of Flat Plate.” Study the air flow around the leading edge at 5
m/s free stream velocity and determine the laminar velocity boundary layer at different
locations on the upper side of the leading edge and compare with the Blasius solution. Also,
compare the local friction coefficient with figure 2.26. Use different values of the initial mesh
to see how it affects the results.

Figure E1. Leading edge of asymmetric flat plate; see Fransson (2004)

2.5 Modify the geometry of the flow region used in this chapter by changing the slope of the
upper ideal wall so that it is not parallel with the lower flat plate. By doing this you get a
streamwise pressure gradient in the flow. Use air at 5 m/s and compare your laminar
boundary layer velocity profiles for both accelerating and decelerating free stream flow with
profiles without a streamwise pressure gradient.

Figure E2. Example of geometry for a decelerating outer free stream flow

Chapter 2 - 35 -



Flat Plate Boundary Layer

2.6 Determine the displacement thickness, momentum thickness and shape factor for the
turbulent boundary layers in figure 2.30a) and determine the percent differences as compared
with empirical data.

2.7 Change the distribution of cells using different values of the ratios in the X and Y directions,
see figure 2.28b), for the turbulent boundary layer and plot graphs of the boundary layer
thickness, displacement thickness, momentum thickness and local friction coefficient versus
Reynolds number for different combinations of ratios. Compare with theoretical results.

2.8 Use different fluids, surface roughness, free stream velocities and length of the computational
domain to compare the average friction coefficient over the entire flat plate with figure E3.
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Figure E3 Average friction coefficient for flow over smooth and rough flat plates, White (1999)
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